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Design Tools  
 
 
   Select 

General 

   Pan 
   Zoom Reset 
   Zoom In 
   Zoom Into 
   Caliper 
   Rotate 
   Delete 
   Zoom Out 
   Zoom Out of 
 
 
Icon  Description 
Select 

 
 

Clicking Select allows you to select an object on the 
Drawing Board. Objects turn red when they are selected. 
To select more than one object, press the shift key while 
you select each object. 
 

Pan 
 

 

Click Pan, then drag an item across the drawing board to 
pan from side to side. 

Zoom Reset 
 

 

Returns you to the view you previously had when the 
drawing board was first opened. 

Zoom In 
  

  
This enlarges the visual display of the selected item. 

Zoom Into 
 

 
Zooms into the currently selected Light, Face, and Point. 

Caliper 
  

  

The calipers cursor is positioned on the drawing board 
where you want the X and Y axis to be situated. The 
cursor’s distance from the x-axis, distance from the y-axis 
and distance from the axis point (i.e. 0,0) is shown at the 
bottom of the dialog box. On the frame drawing board, the 
calipers allow you to define and measure distances 
between objects. 
 

Rotate 
  
 

Rotates the frame to the orientation you want. 

Delete 
  

 
Deletes the item you have selected on the drawing board. 

Zoom Out 
  
 

This reduces the visual display of the selected item. 

Zoom Out of 
 

Zooms out of the current view. 
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Design Tools        
 
  
 
 
 Section 1 - 
   Merge Lite 

Wireframe Tab 

   Lock / Unlock Points 
    
 Section 2 - 
   Nested Frames 

Resources Tab 

   Assembly Substitution 
   Reverse Assembly 
   Merge Assemblies 

  Lights Equal on Height 
   Add Frame View 
 
 Section 3 - 
  

Joints Tab 

 
 Section 4 - 
   Thumbnail 

Tools Tab 

   Refresh 
     
 Section 5 -
   Options Wizard 

Wizards Tab 

   Assembly Wizard 
   Grid Frame Wizard   
   Stepped Frame Wizard 
   Split Light Wizard 

  Horizontal Dimension Wizard 
  Vertical Dimension Wizard 
   
 
Section 6 -Macro Tab –
  Can consist of some or all of these depending on the 

   framing system. 

  

  Door Macro 
  Height & Width Macro 
  Lite By Lite Glazing Macro 
  Sub-Head & Sub-Sill Macro 
  Angle Macro 
  Raked Frame 
  Curved Frame 
  Nested Frame 
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Design Tools  
 

Section 1 - Wireframe Tab 
 
 
 
Merge Light  
 
 
 
 
 
 
 
 
If you require to Merge Lights this can be achieved by the following steps - 
 

  You need to be in the Zoomed in View on your Drawing Board. Click on the  frame 

so it is highlighted red, then click on the  button. 
 Select the Lights that you want to merge by either selecting them on the drawing 

board or under the Objects Tree. (Remembering that if you want to select more than 
one light to hold the Shift Key on your Keyboard). 

 Click on the Wireframe Tab and click on the  button. 
 This will display the following box asking you which light you would like to keep. 

 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  Once you have selected the Light you would like to keep then click on the 
 button. This will then Merge the Lights. 
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Unlock and Lock Points 
 
When you are creating a Frame (eg; light code 22) by default the Points are locked, so 
when you move Points and Lines these will move as one. To unlock points- 
 

 You need to be in the Zoomed in View on your Drawing Board. Click on the 

frame so it is highlighted red, then click on the  button. 
 

 Drag your mouse over the Lines and Points that you want to Unlock so these 
are highlighted red. (See the following picture). 

 Then click on the button to Unlock the points. Or to lock the points click 

on the  button.  
 

• In this example the whole transom could be moved up and down by clicking 
either side transom and moving it. If you wished to move the transoms 
separately you will need to Unlock the Lines and Points of the transom and 
jambs. 
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Section 2 - Resources Tab 
 
Nested Frame  
 
 
 
 
 
 
 

 Note: The Nested Frame Macro on the Macro tab should be used instead as this 
eliminates the possibility of placing a nested frame into an incorrect receptor. 
 Refer Section 6 of this manual. 

 
To Nest Glass use following steps - 

 
• You need to be in the Zoomed in View on your Drawing Board. Click on the 

frame so it is highlighted red, then click on the  button. 
 

• Select the Light so it is Highlighted red. Click on the Resources Tab and click on the 

following icon . 
 

• This will display a Frame Picker Browser, from here you are can only select to place 
glass into the lite. 
 

• Select from the list then click on the  button. 
 

 This will then display a “Place ……………. in Receptor?” box, like the following. 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Select the Glass Receptor and click the  button. 
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Assembly Substitution 
 
 
 
 
 
 
 
 
 
If you require a different Assembly to the one that you first selected you are able to 
use the Substitution icon. 
 

 Select the Assembly which you want to Substitute, by selecting it in the 
Objects Tree. 

 Click on the Resources Tab and click on the  button. 
 This will bring up an Assembly Picker Box, select the Assembly you require 

and click on the  button. 
 This will then Substitute the Assembly for the one that you have selected. 

 
 

 
Note: If the Assembly that you have selected does not substitute make sure to 
check that your joints have remained. 
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Reverse Assembly 
 
 
 
 
 
 
 
 
 
Once you have placed an Assembly onto your frame and if you notice that the 
Extrusion you require is on the wrong side you can select Reverse Assembly. This 
will reverse the Assembly. 

 
 Select the Assembly that you want to Reverse, by selecting it in the 

Objects Tree. 

 Click on the resources tab then click on the following icon , this will 
reverse the Assembly. 

 
 

 
Note: This should not need to be used as the database has been designed to 
orientate the assemblies the correct way around. 
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Merge Assemblies 
 
 
 
 
 
 
 
 
 
This is used after  placing assemblies across 2 or more lites via the assembly 
wizard. (Refer page 20) 
 
If you require to Merge Assemblies this is achieved by the following – 
 

 Select the Assemblies by selecting them in the Objects Tree, remembering to 
Hold Shift on your Keyboard to select more than one. 

 Click on the Resources Tab and then click on the  button. 
 This will then merge the Assemblies. 
 
Note: Make sure that your points have been locked. After merging you will need 

to fix the joints – Refer Section 3 – Joints tab. 
 
 
Example – Merging two AS106 sub sills. 
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Lights Equal on Width 
 
 
 
 
 
 
 
 
 
 
If you require to make the Lights Equal on Width this is achieved by the following – 
 

 Select the Lights that you want to make equal, by clicking and selecting them 
on your drawing board, remembering to hold the Shift Key on your keyboard 
to select more than one. 

 Click on the Resources Tab and then click on the  button. 
 This will then display the following box, asking you to select which Receptor 

to use. 
 
  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Select the Receptor and press the OK Button.  
 
Note: To Achieve equal Glass and Equal Heads and Sills use the Glass or Daylight 
Receptor. 
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Lights Equal on Height 
 
 
 
 
 
 
 
 
 
If you require to make the Lights Equal on Height this is achieved by the following – 
 

 Select the Lights that you want to make equal, by clicking and selecting them 
on your drawing board, remembering to hold the Shift Key on your keyboard 
to select more than one. 

 Click on the Resources Tab and then click on the  button. 
 This will then display the following box, asking you to select which Receptor 

to use. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 

  Select the Receptor and press the OK Button.  
 
Note: To Achieve equal Glass use the Glass or Daylight Receptor. 
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Add Frame View 
 
 
 
 
 
 
 

Frame View is denoted by a graphic of a video camera.   
You must be in Frame View to use this function. 
 
Frame View allows the estimator to capture of snap-shot of the frame at any angle or 

view they wish.    Simply generate the view or rotation you wish and press the  
button.   This Frame view taken is added to the Objects tree from where it can be 
viewed at any time.  
 
To view a previously saved Frame View –  
1.  Select the View from the Object tree    2) Right-click and select EDIT   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Note: to view the Frame Views in the Objects Tree select Zoom out of mode   
 
Frame View snap-shots are also available for use within the Presentation tab. 
 

RESULT – 
Frame View is 
displayed 
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Section 3 - Joints Tab 
 
 
 
 
 
 
 
 
 
This function is generally taken care of automatically when the grid frame wizard is 
run but can be useful if a joint is not correct. 
Instructions below explain how to correct a cut. 
 

• Click on the Joints tab. 
 

• Click on the Frame so it is highlighted Red. Click on the  button, to zoom 
into the Frame. (If you are not already zoomed in). 
 

• Make sure you have your Points Displayed on the Drawing Board. Right Click 
and go to Display. Make sure the Points has a check next to it. 
 

• Select one of the Points on the outer Frame. This can be done by either 
clicking on the point on the Drawing Board or selecting it in the Objects tree 
on the left hand side. 
 

 Click on the  button and this will zoom into the point you have selected. 
This will then look like the following. 
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Joints Tab (Continued) 
 
 

 You now need to select the Extrusion and the Buttline you would like to join. 
This is done by holding the Shift Key on your Keyboard and selecting the two 
from the Objects Tree on the Left hand side. See the following picture. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Note: All the Butt Lines are in Upper Case and all the Extrusion names 
are in Proper Case. 

 
 
 

 The drawing board will then look like the following. 
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Joints Tab (Continued) 
 
 

• You will notice that our Head Extrusion has been selected and our 
HEAD/SILL Buttline has been selected. We can now join the two. 
 

 Click on the  button and this will join the two. Your Drawing Board 
should now look like the following. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 You will notice that the two have joined. You will need to repeat these steps 
for all of the Points that you would like to join.
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Section 4 - Tools Tab 
 
 
Thumbnail 
 
 
 
 
 
 
 
 
 
When you create a Frame in the Design View you are able to take what’s called a Thumbnail. 
This is a picture of your frame that you have created. This picture will then be placed on your 
reports. The Thumbnail can be taken either when you are Zoomed Into the Frame or Zoomed 
out of the Frame. 
 
You may want certain things not to be displayed when you take a Thumbnail such as the 
Points for a neater appearing picture. To do this Right Click on the Drawing Board and click 
on Display. The following menu appears. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
From this menu you can select or de-select what you require or don’t require. 
 
Click on the Tools tab and then click on the  button. You will notice that a Thumbnail 
now appears on the bottom Left Hand corner of the quote of that particular item. 
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Refresh 
 
 
 
 
 
 
 
 
 
 
 
 
 

To Refresh the view within the Design Tab click on the Tools tab and click on the , this 
will refresh the view.
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Section 5 - Wizards Tab 
 
Options Wizard 
 
 
 
 
 
 
 
Here you are able to select Finishes, Glass and change Frame Options. 
 

 Click on the Wizards Tab then click on the  button. This will display the 
following screen. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
You will notice that this is the same screen that is displayed from within the Defaults 
Tab within the quote and also the Items/Options Tab, Edit Options. 
 

 By clicking on the  will bring up a picker box for you to select either Finish 
or Glass. (View next page) 
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Options Wizard (Continued) 
 
From within this screen you are also able to change frame options. 
 

 Click on the Frame Options Tab. Here it lists all the available options for that 
frame. 

 Clicking next to a frame option will bring down a drop down menu allowing 
you to select from the choices listed. This can also be done from within 
Items/Options Tab. 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 A tick in this box will show only the options you can select. 

IMPORTANT 
Do Not check or 
uncheck these boxes. 
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Assembly Wizard 
 
 
 
 
 
 
 
 
 
If you require an Assembly to be placed within a Light or Lights this can be done by 
the following steps – 
 

 Click on the Frame so it is highlighted Red. Click on the  button, to zoom 
into the Frame. 

 Select the Light or Lights which the Assembly is to be placed on. 
 Click on the Wizards Tab and then click on the  button. 
 This will display the following box. 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

 Select where you want to place the Assembly by de-selecting the Check Boxes 
and only leaving the one where you want to place the Assembly. Eg. For a Sill 
it should look like the following. 

 
 
 

Note: This wizard is required when placing sub sills only partly across the sill 
of a frame (2 or more lites next to a door). After inserting the assembly you 
will need to use the Merge Assembly wizard to ensure the sub sill is one 

continuous length. (Refer page 9) 
  It is also useful when placing horizontal beads in the Hastings Suite when the 
 mullions are structurally   glazed. 
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Assembly Wizard (Continued) 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• You are now able to select your Assembly by clicking on the  this will then 
display an Assembly Picker Box, select from the List and then click on the 

 button. 
 

• You will need to select the Receptor that you want to place this on. Click on the 
dropdown arrow and select the Receptor. 
 

• Once you have selected click on the  button and this will place the 
Assembly onto your Wireframe. 
 

 You will need to make sure that your Joints are correct. 
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Grid Frame Wizard            
 
 
 
 
 
 
 
 
 
Each Frame Group within the ALSPEC database has a DESIGN frame. 
 
IT IS STRONGLY ADVISED that you use this DESIGN frame whenever a special 
shape/style is required. 
 
 
Once you have added your Design Frame (by adding a standard existing frame) to the Quote 
it is now time to create the frame using the Grid Frame Wizard.. The Grid Frame Wizard 
allows you to create a complete frame. 
 

 Click on the Design Tab from within the Quote -  Select the Wizards Tab and Click 

on the following icon , this will then display the following screen. 
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Enter the Frame Height & Width 
 
Enter in the Height and Width of the frame. (Millimetres) 
 
Layout 
 
Enter in the Number of Rows (i.e. Horizontals) and/or enter in the Number of Columns (i.e. 
Verticals). 
 
Light Code 
 
If the number of rows is to be different for each column, enter a light code in this field. 
Entering a light code (instead of columns and rows) can create frames that have a different 
number of lights in each column. Eg. A light Code of 213 will draw the following Wire 
Frame. ie. 2 Lights, 1 Light, 3 Lights. 
 

 
 
Create Frame with Equal Lights 
 
Check this box to create equal lights.  
 

 Clicking on the Custom button will present the following screen. 
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Assemblies Tab 
 
This tab allows you to select the Assemblies that are going to be placed onto your Wireframe. 
These will be set to defaults but you are able to select others by clicking on the  Button 
will bring up an Assembly Browser.  
 
Select from the list then click the  button. Repeat this step until you have placed 
Assemblies on all of the Lines. 
 

Note: For internal lines such as Transom and Mullions if you have selected more 
than one, these can be selected here and then Substituted at a later stage. Please 
see steps that follow. 

 
 
 
 
 
Glass Tab 
 
This tab allows you to select the Glass that you require for the Frame. This can also be 
done on the Items/Options Tab, Edit Options. 
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Joints Tab 
 
This tab allows you to set the joints for the Outer Framing. The default joints are the 
following. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Joints have been set to a Default of the above. For both Outer Framing and Internal Cuts. 
 
By clicking on the arrow will produce the following drop down menu, allowing you to select 
what Assembly will run through or which one will cut on the outer points of the frame. 
However these shouldn’t need to be changed from what they are. 
 

 
 
This represents the Head and Sill are cut between the Jambs. 
 
 
Click on the  button once you have finished this will then populate your 
Wireframe. 
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Joints Tab (Continued) 
 
 
Your drawing board should now look like the following – 
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Stepped Frame Wizard 
 
 
 
 
 
 
 
 
 
To create a frame with a stepped sill in V6, you must first create a rectangular frame with all 
assemblies and fills, then remove a portion of the frame. The Stepped Frame Wizard performs 
the removal. 
 
The Wizard will need a Head or Sill Assembly to be selected in order to complete the 
operation. It will remove all the Assemblies on the Head, Sill, left and right Jamb surrounding 
the Light, and split any up if necessary. The first internal horizontal assembly found will be 
substituted for the new head or sill assembly. 
 
A step will be created where at least two lights exist, one of top of the other. In the case where 
only one light exist the entire light including head/sill and fill will be removed. 
 
V6 will automatically shorten vertical Assemblies – such as Jambs and Mullions, and will 
remove Lights and Fills, and place sill assemblies along the new edge and reconstruct all 
joints during the process. 
 
If you require to Step a Frame this is achieved by the following steps – 
 

• Click on the Frame so it is highlighted Red. Click on the  button, to zoom 
into the Frame. 
 

 Click on the Light so it is highlighted Red.  
 

Eg. Your frame will look something like the following – 
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Stepped Frame Wizard (Continued) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 Click on the Wizards Tab and click on the  button. 
 This will display the following box – 

 
 
 
 
 
 
 
 
 
 
 

• Click . 
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Stepped Frame Wizard (Continued) 
 

 
 Your drawing board will then look like the following – 



                                                                               Soft Tech                                      
 
     

Documentation Updated by ARM 
10th August 2010  

30 

 
Split Light Wizard 
 
 
 
 
 
 
 
 
 
 
If you require to Split the Lights this is achieved by the following steps – 
 

 Click on the Frame so it is highlighted Red. Click on the  button, to zoom 
into the Frame. 

 Select the Light or Lights that you want to Split. 

 Click on the Wizards Tab and click on the  button. 
 This will then display the following box. 

 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Enter in a Light Code. 
 

eg. Entering in a 2 will display the following within a light - 
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Split Light Wizard (Continued) 
 

 
 
Entering in a 11 will display the following within a light - 
 

 
 

 Select the Assemblies that you want to place on the Horizontal and the Vertical. 
(These will be set to the default but can be changed here). 

 Select the Joints (this will be set to the default). 
 
Note: Using the Split Light Wizard on this Tab instead of the Split Light Wizard on the 
Wireframe tab will set the Joints for you providing these have been selected. 

 
If there is glass in the lite to be split, the correct receptor needs to be chosen. 
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Horizontal Dimension Wizard 
 
 
  
 
 
 
 
This Wizard allows you to set up a dimension for a Light. This can be done by the following 
steps – 

• Click on the Frame so it is highlighted Red. Click on the  button, to zoom into 
the Frame. 

• Select the Light that you want to place a dimension on. 

 Click on the Wizards Tab and click on the  button. This will then display the 
following screen. 

 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
• Enter in the Width that you want to set the Dimension to. (Millimetres). 

 
• Select the Line that you would like to move, either Left or Right. 

 
• Type in a Name for the Dimension. 

 
• Select the Left Reference Object and the Right Reference Object. This will be 

WIREFRAME. 
 

• Select whether or not you would like to place a Constraint on the Dimension. 
Entering in Minimum & Maximum Values. This will then stop the user from going 
below or above these values. 
 

 Or you are able to Specify a Formula. 
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Vertical Dimension Wizard 
 
 
 
 
 
 
 
This Wizard allows you to set up a dimension for a Light. This can be done by the following 
steps – 

 Click on the Frame so it is highlighted Red. Click on the  button, to zoom into 
the Frame. 

 Select the Light that you want to place a dimension on. 

 Click on the Wizards Tab and click on the  button. This will then display the 
following screen. 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 Enter in the Height that you want to set the Dimension to. (Millimetres). 
 Select the Line that you would like to move, either Top or Bottom. 
 Type in a Name for the Dimension. 
 Select the Left Reference Object and the Right Reference Object. This will be 

WIREFRAME. 
 Select whether or not you would like to place a Constraint on the Dimension. 

Entering in Minimum & Maximum Values. This will then stop the user from going 
below or above these values. 

 Or you are able to Specify a Formula. 
 
Note: When creating Dimension it is important not to move your frame from the 
origin (ie. The dotted line on your drawing board). Make sure you select the correct 
line to move so that you frame does not move off this origin point. 
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Section 6 - Macro Tab 
 
Doors MACRO 
 
 
ALSPEC have created a series of Door Macros within their relevant frames to automate this 
process and ensure no steps are ‘missed’ by operators. 
 
These can be accessed via the Macro Tab –  
 
There is a choice of Hinged, Pivot and Sliding doors in both the 45mm 
Swan or Torrens Doors. 
The 45mm Swan is shown by the blue icons, the Torrens by the Yellow 
icons.  
 
 
 
 
 
 
 
 
 
Instructions for use of these Macros is explained in the Design Trainer Manual –  
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Changing Frame Height and Width MACRO 
 
 
 
 
 
 
 
You must be in FACE view to active this (or any macro) 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Enter the changes required and select OK. 
 

• The Frame Options Wizard will then appear with default setting in place, you 
can make any required changes or just select OK. 

 
 
 
 
 
 
 
 
 
 
 

• The Frame in Face View will alter in size accordingly. 
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Lite By Lite Glazing MACRO 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
When selected this Macro will display the current frame with BLUE edges around 
each lite which contains Glass.    The Glass selected within each lite at this stage will 
depend on the selection made under DEFAULTS. 
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Lite By Lite Glazing MACRO (Continued) 
 
To change any Glass selection already made, simply click on the lite (or lites by 
holding the SHIFT key down) to be changed and select the Glass button. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
This will take you to the Glass Browser from where you can select the appropriate 
glass type. 
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Step 2 
Select the appropriate 
Sub-Sill 

Sub-Head & Sub-Sill MACRO 
 
 
 
 
 
This Macro is designed to let the estimator select fixing options including Sub 
Head/Sill and Fixing/Trim Angles to various parts of the frame on the Drawing 
Board. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Step 6 
Select the appropriate 
combination of 
Angles and location 
 

Step 3 
Nominate Sub-Jamb 
if required 
 

Step 1 
Select the appropriate 
Sub-Head 

Step 4 
Nominate to change 
Frame size to allow 
for fixings 
 

Step 5 
Nominate any Over-
run for the Sub-Head 
/Sill. 
 

Step 7 
Nominate Frame 
adjustment for Angles 
 

Step 8 
Nominate any Over-
run for the Angles. 
 

Step 9 
Tick Defaults Box if you wish to keep you 
set-up for next time and select OK. 
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Sub-Head & Sub-Sill MACRO (Continued) 
 
 
 
 
The following notification is then displayed to ensure you understand that the Height 
of the Frame has been ADJUSTED to allow for the Sub-Head and/or Sub-Sill 
combinations 

 
 
 
 
 
 
 
 

 
 
 
The BOM will now reflect the selected Sub-Head and/or Sub-Sill. 
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Raked Frame MACRO 
 
 
 
 
 
 
 
 
 
This Macro is designed to lead the estimator through the necessary steps to rake a 
frame on the Drawing Board. 

 
This Displays the following Box. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Select which end of the Frame you want to move either Top or Bottom. 
 Change either the Value of the Left Jamb or the Right Jamb. 
 
E.g. Enter Move Top and Right Jamb 800 
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Raked Frame MACRO (Continued 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Will produce the end result of – 
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Curved Frame MACRO 
 
 
 
 
 
 
 
This Macro is designed to lead the estimator through the necessary steps to curve a 
frame on the Drawing Board. 
 
This Displays the following Box. 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Will produce the end result of – 
 
 

Select the Curve Height 
 
E.g. Enter Curve Height 200 
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Curved Frame MACRO (Continued) 
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Nested Frame MACRO 
 
 
 
 
 
 
 
 
 
 
 
 
 
ALSPEC have created a Nested Frame Macro within their relevant frames to automate this 
process and ensure no steps are ‘missed’ by operators. 
 
A demonstration of this Macro can be viewed in the Design Trainer Manual  
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